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SECTION I - GENERAL DESCRIPTION

A. INTRODUCTION

Welcome to HuntMaster. You are about to enter into the age of advanced radiolocalization
technology! This software package when connected to anappropriate Radio DirectionFinding
Instrument and provided of a GPS localization receiver makes up a complete radiogoneometric
system with mapping and triangulation capabilities. This Software is intended for professional
localizationof anyRF signal. Beenspeciallysuited for object localization (bymeans of beacons),
interference localization, and intelligence information gathering. HuntMaster is also capable of
logging all DF and GPS information for later analysis. HuntMaster's Net Edition increases
direction finding capabilities by allowing real time triangulation from various fixed or mobile
remote DF sites by means of TCP/IP (Internet) data links.

HuntMaster is not just a graphical displaying tool. Based on advanced data processing
algorithms the software takes advantage of every bit of information provided by the RDF
Instruments in use. That information in conjunction witha moving map display, withGPS vehicle
tracking is used to triangulate the unknown position of any RF Signal Source. The use of a
Maximum Likelihood Probabilistic Region (MLPR) Display overlaid on top of the map gives
detailed information of the most probable area for the unknownsignal source (transmitter) to be
located. The MLPR is a state-of-the-art Econometric Model Algorithm that drastically improves
the ability to chase and localize any class of RF Source.

A Radar like display is used to filter out any unwanted multipath distorted bearings, helping the
DF Operator in his hard work of selecting whichmeasurements to trust on, and which to discard
as inaccurate. By giving an easily readout of dozens of RDF measurements at a glance, the DF
Operator can now take a much better decision based on a much larger dataset. This filtering
does create muchbetter and reliable bearing informationset from which to triangulate the signal
source.

Refer to the front-cover illustration for all references to HuntMaster's main-screen.

B. HARDWARE AND OPERATING SYSTEM REQUIREMENTS

HuntMaster is written for Windows 2000/XP. We recommend that the host computer be a
Pentium III900 MHzor better withat least 256 MB of RAM. The computer monitor should have at
least 1024x768 pixels witha color display. If the software is intended to be connected locally to a
DF Processor and or GPS Receiver, then one or two RS-232 serial (COM) port have to be
available. If serial ports are not available (as is the case with most current laptop units), a USB
port can be used via an appropriate USB-to-serial adaptor. Be advised, however, that these
adaptors do not always function transparently. The selected adaptor should therefore be tested
to verify that it works properlywith the DF Processor beenused and the selected GPS Receiver
with regards to both speed and compatibility. We have found that certain models do not work
well with all the supported host receivers and therefore strongly recommend that the selected
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adaptor be tested thoroughly. For further information on how to connect ‘RDF Products’ DF
processors, refer to the DFP-1000B Operator’s Manual for important additional informationon
this topic.

C. RDF UNITS SUPPORTED

HuntMaster Version5.0.9 and above canoperate with two different sets of RDF Units,depending
on the vendor's you have ordered the software from. This are:

· Any 'RDF Products' unit of the DFP-10x0B series. This are: DFP-1000B, DFP-1010B,
DFR-1000B or DFR-1010B.

· Using HuntMaster's SoftDoppler Module and appropriate Hardware. SoftDoppler is a
Software DF Processor for Quasi-Doppler DF antenna arrays.

USING 'RDF PRODUCTS' DF UNITS

To use HuntMaster with a 'RDF Products' DF Processor Unit please proceed to the 'RDF
Products Units as DF Processor' topic for additional information.

If you already have an 'RDF Products' DF System setup running, then: execute DefCon2b and
HuntMaster. DefCon2b will let the DF Operator to control the RDF Unit from the PC computer,
while at the same time it forwards all the DF information retrieved from the DF Unit to HuntMaster.
Therefore, remember to run DefCon2b each time you intend to use HuntMaster. If DefCon2b is
closed, then HuntMaster will stop displaying new DF data.

USING 'SOFTDOPPER' DFING

To use HuntMaster's SoftDopper DF Processor you will be required to purchase additional
hardware. A quasi-doppler antenna, and a Digital Interface Unit (DIU) are required pieces of
equipment. Please proceed to the 'SoftDoppler as DF Processor' topic for additional information.

D. 'RDF PRODUCTS' UNITS AS DF PROCESSOR

The complete HuntMaster radiogoneometry system using anyof 'RDF Products' Series B Units
as HuntMaster's DF Processor consist of the following items:

· 'RDF Products' Series B RDF Unit connected to laptop's COM Port & 12vDC. All 'RDF
Products' unit of this Series up to date are: DFP-1000B, DFP-1010B, DFR-1000B or
DFR-1010B

· Appropriate Radio Receiver (connected to RDF Unit)
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· Adcock Radio Direction Finding Antenna (connected to RDF Unit)

· GPS receiver (connected to RDF Unit or to a computer's COM Port)

· A digitized map, or satellite image of the region where localization will take place

· HuntMaster software running on PC computer

· 'RDF Products' DefCon2b Remote PC Control of the RDF Unit. Make sure to have anup-
to-date copyof DefCon2b installed in the computer. For HuntMaster to communicate,you
will require DefCon2b Ver. 1.2.5 or above. DefCon2b is a PC control program provided
by 'RDF Products' that does interface between the Hardware RDF Unit, and HuntMaster.
This software lets the operator to control the RDF Unit from the same PC screenwherehe
is operating HuntMaster.

Note: For additional information on 'RDF Products' configuration, connection and operation
refer to the Operator’s Manual provided with those units, or contact 'RDF Products' at:
www.rdfproducts.com.

The connection diagram of the above equipment is the following:
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To run HuntMaster using these RDF units, please proceed as follows:

1. RunDefCon2b, and make sure that the DFP and DefCon2b are communicating properly.
If not, check that the DF Processor unit is connected to one of the PC's COM Ports, and that
DefCon2b's COM Port settings are set accordingly.
2. Run HuntMaster. You will see all the DF information retrieved by DefCon2b on
HuntMaster's screen.

Please remember that for HuntMaster to operate properly DefCon2b will have to be openat all
times. If DefCon2b is closed, then HuntMaster will stop receiving DF Data from the DFP unit.

E. SOFTDOPPER AS DF PROCESSOR

The complete HuntMaster radiogoneometry system using SoftDoppler as the DF Processor
consist of the following items:

· HuntMaster software running on laptop computer

· Digital Interface Unit (DIU) connected to laptop & 12v DC

· FM VHF/UHF Receiver (connected to DIU)

· 4/6/8 Elements Antenna w/switching array (connected to DIU & Receiver)

· GPS receiver (connected to DIU)

· A digitized map, or satellite image of the region where hunting will take place

· An external speaker w/enclosure (connected to DIU)

The laptop computer should meet the following minimum requirements to runHuntMastersuit:PC
computer running Win2000/XP withat least 256Mb of RAM and a Pentium III900MhzProcessor.
The main requirement is a 16bit Full-Duplex A/D Audio Board with Line-In and Speaker Out
jacks. With sampling rates from 8Khz to 48Khz. The FM Receiver should be a good
communications grade receiver with a wide and linear IF & AF bandwidth (generally 9600bps
ready radios meet this requirements). Of course selectivity should be as good as possible.
Therefore it is not recommended to use a poor quality receiver unit, as this will compromise the
overall performance of the SoftDoppler unit. The Antenna Array and switching circuit should be
any compatible with the Roanoke Doppler unit. It is strongly suggested to use the wide antenna
switcher array, posted by Joseph D. Moell (K0OV) in 'Homing In' webpage. The GPS receiver
should be a 12 channel unit (if possible), with RS-232 serial connection. The unit must handle
4800bps NMEA signals to communicate withHuntMaster software. It is advisable to have a map
of the hunting area so that the Map Module can show at all times the positionof the vehicle over
the map (please refer to the Map chapter for more details). Finally a good quality external
speaker should be provided by the user to listen to received audio while hunting. The DIU has a
built in 0.2W audio power amplifier with software volume control.
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The connection diagram of the above equipment is the following:

Once youhave successfully interconnected all items, youmust proceed to setup the laptop audio
board mixer, configure the SoftDoppler, and finally calibrate it. Please refer to the following
section to continue with the installation.

F. OPERATOR’S MANUAL APPLICABILITY

As of this writing, this manual is applicable to HuntMaster Express and Net Editions Version
5.1.24. Reference to ‘RDF Products’Remote DF Control Program DefCon2b Version1.2.5,and
DF Processors DFP-1000B/DFP-1010B and made throughout the manual.
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SECTION II - PROGRAM INSTALLATION

A. INSTALLING SOFTWARE

HuntMaster canbe easilyDownloaded from HuntMaster’s On-Line FTP Server. To receiveaURL
Link to the latest release version available of the product, please contact us. A Downloadable
Distribution Package in ZIP format is available for you to Install/Upgrade your computer.

For successful installation, follow the following Installation Instructions:

· Unzip the downloaded file in a temporary folder.

· The required installation files for HuntMaster installation files are “HuntMaster.CAB”,
“setup.exe”, and “SETUP.LST”. The executable installation file for this program is
"setup.exe".

· Setup.exe can be run directly from the temporary folder.

· All 3 files contained in this folder must be present for a successful installation.

· Uninstall any earlier versions of HuntMaster is not necessary to upgrade the product to a
new release. Nevertheless, exit HuntMaster before attempting to upgrade the software.

· To begin the installation, click on "setup.exe" in Windows Explorer.

· Select a suitable mainprogram folder (e.g., "C:\Program Files\HuntMaster"). If this folder
does not already exist, it will be automatically created.

· Select the default program group (HuntMaster).

· During the installationprocess, anadvisorymessage mayappear warning that files being
copied to the computer are not newer (i.e., that are less current) thanexisting files of the
same name already on the system. When this occurs, select the option to keep the
existing files.

· The executable program file is "HuntMaster.exe". This file can be used to create a
shortcut on your Windows desktop.

Note I: It is not necessary to restart your computer following HuntMaster installation.

Note II:If a USB serial hub is to be connected to the computer to provide the required two serial
ports, then follow the hardware and software installation instructions accompanying that
product.
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B. REGISTERING SOFTWARE

Once you buy a license of HuntMaster software you should then register it. Until you do not
complete the registration process you won't be able to use HuntMaster. To be able to run this
software you must first activate it. To do so, youmust enter anappropriate User ActivationKey.
This key will be e-mailed to you and will make your purchased license valid ONLY on the PC
computer youare activating the product. The activationprocess is veryeasy, please proceed as
indicated below.

To start the registrationprocess, run the program, and press the 'Registration' button (located in
the right bottom corner of the form) on the Splash Window seen above. You will have only 4
seconds to do so before the application closes. You will then see the Registration Form:

Fill the first two fields. 'Register to' field should include your complete name and any extra
information (such as license number). While in the 'PIN Code' field the PIN Code provided in
HuntMaster purchase should be typed in. If you bought more than one HuntMaster license then
proceed in the same way with each of the licensees (in each PC computer). After entering the
information press the button for your preferred registrationmethod (on-line or paste to clipboard
to send it via mail). If you select the on-line activation method then you will see the following
window if your information has been successfully submitted:
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Remember to always have a hard copyof your 'Registered to' and 'PIN Code' information, asyou
maybe asked this informationwhenrequiring technical support or whenneeding to migrate your
Activation Key to a different hardware (PC computer). In the event of anychange in the OS, HD,
hardware upgrades, etc you will need to run again the whole Registration Process (as you will
need a new User ActivationKey). Youare therefore advised not to undertake computer changes
before a planned radiogoneometry job.

If you want to change your Activation Key from one computer to another, you should first de-
register your actual license. To do so please contact HuntMaster by e-mail at:
alex@HuntMaster.com.ar.
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SECTION III - 'IP DF Controller' Module

A. OPERATION

The 'IP DF Controller' Module is mainly a display readout window, having just one control
available to the user. Nevertheless it's simplicity, this window integrates the whole RDF Bearing
information available from a single RDF unit or from an RDF Network (where various radio
direction units are integrated into a multi-site tracking configuration network).

B. SINGLE RDF CONFIGURATION

The 'IP DF Controller' Window when operating with only one RDF Unit attached, displayes one
pair of digital DOA & Mode indicators. The Direction-of-Arrival (DOA) Bearing Angle is the one
HuntMaster receives from the DFP Unit rounded to the nearest tenth of a degree. The Mode
indication, is the same one displayed graphically by the Radar Module. The Mode indication is
rounded to 1, 2, 3, 4, or 5 degrees using the Radar rounding configuration.

A Signal Level Meter is continuously reporting the DF Bearing's Signal Quality. This is a very
important piece of information for any DF Operator to know if the data been received from the
RDF Unit is good enough to perform computations with it. As a rule of thumb, poor quality
measurements don't tend to give good Mode Indications that can thenbe used for plotting on the
map to perform MLPR, Triangulations with it.

To automatically discard any poor measurements, the 'IP DF Controller' Module has a 'Signal
Quality Muting' Feature. This slider control has a squelch-like behavior. When any given DF
Measurement has a DF Signal Quality which is below the preset threshold of the Signal Quality
Muting Slider, then this information will be discarded. It neither be displayed in the 'IP DF
Controller' Module, nor it will be used by the Radar Module to compute the Mode Angle. For the
user to be aware of this situation, the background of both, DOA & Mode displays becomes red,
instead of green.
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C. RDF NETWORK CONFIGURATION (Only available in HuntMaster Net
Edition)

When the 'IP DF Controller' Window operates with several DFP data feeds configured, it
becomes a truly multi-site radiolocalization network. Except from a local DFP Unit that may be
connected thru a COM/USB Adapter Cable, all other DFP Units are generally located at remote
sites. The interconnection is done using high-speed VPN or Internet connections.

HuntMaster Net will display a set of DOA & Mode indicators per each RDF Unit available (it
doesn't matter if theyare locallyor remotelyunits). For the user information, whenmore thanone
RDF Units are available in the network, HuntMaster indicates the local unit with the legend '(local)'
next to the RDF Station's Name and ID Number. The Name is always configured to be something
easy for the operator to recognize. It can be the name of the Street where a fixed-site DF Unit is
located. It can be the name of a squadron if it's a mobile DF Unit, or anyother easy to recognize
caption. The ID Number is the unique identificationcode of the RDF Station in the Network. Each
RDF Unit must have a different number that identifies it.
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D. BEARING ANGLE REFERENCE CONVENTION

Throughout the 'IP DF Controller' Module all the DF Bearing Angles are relative to True North.
Both in DOA & Mode Digital Readouts. To calculate the True North Angles, Digital Compass
information is used (if no Digital Compass available, then GPS Heading is used instead).

mailto:info@HuntMaster.com.ar
http://www.HuntMaster.com.ar


info@HuntMaster.com.ar - Copyright © 2008 by HuntMaster Corp - www.HuntMaster.com.ar

 20 of 66 - Operator’s Manual - HuntMaster Corp.

SECTION IV - RADAR MODULE

A. OVERVIEW

This software module is the graphical display readout for RDF Measurements, including also
bearings post-processing & filtering. By giving an easily readout of dozens of RDF
measurements at a glance, the DF Operator can now take a much better decision based on a
much larger dataset. The Radar displayhas also a Timer, whichcanbe used to displayelapsed
time, or pauses between periodic transmissions.

The Radar works in the following way: A 360 degree radar like displayshows the last measured
value with a small red dot on the outer side of the main circle. At the same time, each new
measurements (above the Minimum Signal Quality Muting Level) is displayed as a small line
starting from the center of the Radar display, and in the direction of the measured bearing. The
measured angle received from the DF Processor is rounded off to 1, 2, 3, 4 or 5 degrees
(depending on the Radar Configuration) before displaying this lines. In the event of two or more
bearings in the same direction, those lines became longer and longer. The longest of those lines
is called Mode. This line is displayed in red color, and showed together with the DF's Bearing
Angle. The Mode Angle is the statistic mode of all the measurements takenby the RDF Unit ina
certainperiod of time. Inserious radiogonemertyapplications the Mode Angle (and not the plain
RDF Bearing Angle) is used to workout the triangulation process over the map and into the
MLPR (Maximum Likelihood Probability Region) Model.

Notice that by using the Mode Angle the precision of the plotted line of bearing is increases
drastically. As the more measurements used to calculate the Mode Angle, the more accurate the
result is. On the contrary, if working with just plain (or evenaveraged) bearings the plotted angles
accuracy could be reduced by heavy multipath, noise, or other types of random errors. This
happens because the average function is NOT anunbiased minimum variance estimator of the
actual bearing. While the mode function IS anunbiased estimator. A simple example is whenyou
have most of the bearings to the front of the car (0 degree angle), but occasionally there aresome
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reflections from the back (180 degree). Then the simple average between those measurements
is always a number higher than zero (probably in the region between 10-30 degrees), while
intuitively the best bet is to go right straight forward! In this particular case, the mode would have
been just zero. Therefore, the Mode Angle gives the same kind of results that one would expect
from a highlyskilled DF Operator. At the same time is the theoreticallycorrect method of filtering
DF measurements.

B. OPERATION

The Radar Module has very few command, as it is mainlya display readout unit. Nevertheless, it
has a 'Clear Persistence' option, withcanbe activated bypressing the corresponding button, or
by using the Ctrl-C shortcut. This command clears all lines that have been drawn in the Radar,
while at the same time resetting the Mode Angle calculations. Therefore, the Mode Angle willhold
the last correct Mode Angle, and it will change to the first bearing readout generated by the DF
Unit. It will then start calculating the mode function all over again.

The Clear Persistence command is used when multiple transmissions are taking place in the
same frequency (or when the DF Operator has tuned the DF Radio Receiver to another
frequency). In all other cases, the Clear Persistence option is rarely used, except when very
closed to the RF Source (a few hundred foot or less). In this cases the user could even take the
decision of using just the raw bearing data from the DF Unit to triangulate the unknown signal
source instead of the mode. Keep inmind that the mode is veryaccurate filtering tool, but it hasa
very important time lag to anybearing changes (produced bothbya varying bearing angle, or by
a heading changing vehicle).

The addition of a Timer to the Radar is sometimes used to measure the elapsed time, or to
calculate intermittent transmissionschedules. To reset the Timer press the correspondingbutton,
or the Ctrl-T shortcut.

The main use of the Radar display is to filter by using a graphical tool any multipath induced
bearing errors. As it can be seen in the following situation where very highmultipath is present,
the Radar display was a vital tool to resolve a bearing ambiguity problem.
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BEARING ANGLE REFERENCE CONVENTION

The Radar Displayhas two modes of operation: True North / Relative (depending on theselection
done on: Tools > Options > Radar > "Bearing Display Format"). When the True North option is
selected, then the True North Icon is displayed in the Radar Window. If the True North icon is not
visible, then the relative angles to the vehicles heading is displayed. The Radar displayWindow
True North readings are usefull for Fixed DF Setups, while Relative readings are usefull for
Mobile DF Operation.

The Radar Module does all it's internal math in True North Mode. When operating in Relative
Mode the Radar Display image is rotated 0-360 based on the Digital Compass data. This will
give a relative indiaction, while correctly calculating the Mode at all times. Therefore, a vehicle
can be making turns while the Radar is calculating the Mode. This is a very important feature not
to ruin the measurement due to the constant heading changes of the vehicle. As true north
measurements are used to feed the Radar Mode Calculator, then the angles remainconstant,as
the direction (relative to the north) of the signal source remains constant. As the reader caninfere,
this kind of Mode computation is a very consistent and reliable bearing estimator even when
heading changes are taking place.

NOTE: The "IP DF Controller" Window digital DOA & Mode indicators are still True North
indications, even though the Radar is set for Relative Mode.

C. CONFIGURATION

It is important to understand how the Radar display works to learn how to set it's configuration
parameters. Probably the default values will give acceptable results, nevertheless there are
circumstances where you may want to modify this configuration.

It should be clear that the following configurationwill not onlyaffect the displayed informationbut
also the calculation of the Mode Angle. As it was stated before, the Mode Angle is the statistic
mode of all the DF measurements received in a certain period of time. That period of time is
modified when changing the configurationof the Radar Module. The Mode value is recalculated
each time the radar like display is overloaded, and redrawn smaller, thus allowing to
accommodate new measurements.

Lets now take a look at the three configuration parameters of the Radar Module:

As you can see from the 'Radar' tab of the 'Options' form (located in the 'Tools' menu), this
parameters can only be changed from a set of preselected values.

· Growth: Sets the increase in the corresponding radial line whena measurement in that
direction is recorded. The value is set in the same units as the 'Radius'. Therefore a
growth value of 100 (default) implies that 22 measurements in the same direction are
necessary (assuming a 'Radius' value of 2150) before the whole radar runs into an
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overload condition (and is automatically resized). The time between two consecutiveradar
resizes is the period used by the Mode algorithm to calculate the Mode Angle.

· Rounding: The 'Rounding' parameter is the last of the configurable options of this
software module. This value sets the measured angle rounding used when reading the
bearing information from DF Unit. If Rounding is set to 5 degrees, then all angles will be
rounded to the nearer 5 degree value (for Mode Calculationpurposes only). For example
a 96 degree bearing will be rounded off to 95 degrees. This rounding is necessary,
because if not, there won't be almost any direction in which several measurements
accumulate (and therefore make the line in that direction growth in length). So when this
parameter is set to a higher value (lower accuracy resolution) the user will quicker and
easier see the correct bearing direction. But at the same time, the Mode angle will be
more inaccurate (because it would be round off to 5 degree steps). As before, a certain
tradeoff would be necessary. Usuallya value of 2 to 3 degrees could give the best results
for mobile operation.

· Scale Change: The 'Scale Change' parameter sets the reduction inscale that the Radar
module will undertake when it has to resize the display. A value of 0.5 means that when
resizing the original radar image will be reduced to half its size. A value of 0.25 will reduce
the original image to a 25% of its original size, thus increasing the time betweenresizes.
Nevertheless, the resized image may probably be too small for the user to visuallykeep
track of the bearing direction.

mailto:info@HuntMaster.com.ar
http://www.HuntMaster.com.ar


info@HuntMaster.com.ar - Copyright © 2008 by HuntMaster Corp - www.HuntMaster.com.ar

 24 of 66 - Operator’s Manual - HuntMaster Corp.

SELECTABLE RADAR DISPLAY BEARING MODE (True North / Relative)

The Radar Display has two modes of operation: True North / Relative. The user can choose
betweenanyof these two modes, from the: Tools > Options > Radar > "Bearing DisplayFormat".
When the True North option is selected, then the True North Icon is displayed in the Radar
Window. If the True North icon is not visible, then the relative angles to the vehicles heading is
displayed.

NOTE: The "IP DF Controller" Window digital DOA & Mode indicators are still True North
indications, even though the Radar is set for Relative Mode.
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SECTION V - GPS MODULE

A. OVERVIEW

This software module is mainly a display repeater of the information generated by the GPS
receiver. If the user is using a OEM GPS module (with no display), then this will be his primary
GPS information display.

For the GPS Module to communicate properly with the GPS unit, the later should be configured
for NMEA 4800bps.

It is recommended to use anexternal GPS antenna (if possible anactive one), witha 12 channel
GPS receiver unit. This is the desired configuration, for crowded cityenvironments. If the vehicle
is going to be used on rural areas, then a standard (passive) external antenna maybe enough.
Nevertheless it is not recommended under anycircumstance to use a GPS receiver with it's built-
in antenna inside the car. At least use a low loss cable extension, and locate the antenna on a
roof top mounting bracket.

Keep inmind that for a proper GPS reading 5 satellites should be locked by the GPS receiver at
all times (the absolute minimum for a reading are just 3 satellites).

HuntMaster can interface to the GPS in two different ways:

· By connecting the GPS receiver directly to one of the PC's COM Ports.

· By connecting the GPS receiver to a 'RDF Products' DF Processor Unit, which will
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forward the Latitude and Longitude information from the GPS.

When using the more convenient way of connecting the GPS to the DF Processor, please take
into account that only Latitude and Longitude information from the GPS will be available. For a
complete RDF setup under this scenario, you would need a Digital Compass (connected to the
DF Processor). If you intend to use the GPS Speed, Hearing , or Altitude Information, then you
must connect the GPS receiver to a PC COM Port directly.

B. OPERATION

The GPS module is mainly used to setup the GPS receiver. To open the Virtual GPS window
select the 'GPS Form' from the 'View' menu. This toggle optionwill show/hide the module for the
users convenience. As stated above, the main use of this module is to setup the GPS receiver
antenna. Making sure that the unit is properly receiving the necessaryamount of satellites towork
properly. So it is a very useful tool when testing different GPS antennas, or when setting up the
RS-232 Serial connection and even for checking that the unit is responding properly to vehicle
motion. It is suggested to close the GPS module once in normal DF operation to maximize the
screen area used for the Map module.

GPS CONNECTED DIRECTLY TO COM PORT

If the GPS unit seams not to communicate with the GPS module, then there maybe a problem in
the configurationof the serial port used by the GPS. To modifyHuntMaster serial port, youshould
enter the 'Tools' menu, and from the 'Options' form select the 'Position' tab. Check that the correct
COM port is selected. Youshould now receive data from the GPS receiver. The user mayenable
the NMEA serial port dump to see if the communication between the GPS and the computer is
taking place correctly.

In the GPS configuration tab, the user canalso choose to enable the real time GPS tracking (on
the map). To enable this option just click the 'Use GPS COM Port' ' option. If a GPS receiver is
not available, then this optionshould not be checked, as HuntMaster opens the designatedCOM
port and will be constantly looking for a GPS receiver there.
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Tips: If the GPS position abruptly varies more than a whole degree (in latitude or longitude)
then HuntMaster will mute any GPS information from that moment onwards. Therefore, if you
see that the GPS Module updates it's coordinates, but the Cursor on the Map remains always
in the same position, you should toggle the AUTOPAN button located in the Main Window.
Doing this, will reset the GPS mute feature.

ALTITUDE DISPLAYING

HuntMaster has provision for GPS Altitude Displaying. For this feature to be available the
following two conditions should be meet:

1- The user is operating with a Local DF Unit

2- The GPS is connected directly to HuntMaster via a second COM Port (So that full GPS
NMEA data is available to HuntMaster)

When the above conditions are meet, thenGPS informationwill be available in the Map Window
(next to the GPS Coordinates) and in the GPS Window. Altitude over/under sea level will be
displayed both in real time and will be logged in the .hm files together with the GPS track, and
bearings data.

To enable direct COM Port GPS data the: Tools > Position > "Use GPS COM Port" checkbox
has to be enabled. Using this interconnection mode, HuntMaster reads the $GPGGA (Global
Positioning System Fix Data) where Altitude information is reported by the GPS. When this
information is available, the GPS Altitude informationwill be visible inHuntMaster's GPS window
(Go to: View > GPS), or next to the GPS Lat / Lonon the Map Window. If no Altitude information
is available, then " - - - " will appear in the Altitude Meter of the GPS Window. When a Hunt is
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taking place (and Altitude information is available) it will be logged into the .hm files. This
informationwill be retrieved when the .hm files are played back. Whenplaying back a .hm file, the
recorded GPS Coordinates are displayed in the same Lat/Lon location where the GPS info is
displayed in the Map Window. But the Lat / Lon is appended with the "LOG" caption, for the user
to know that this is a logged GPS Coordinate. Altitude Info (whenavailable) is also displayed in
the same location during mission playback.

GPS CONNECTED THRU 'RDF PRODUCTS' DF PROCESSOR UNIT

Whenconnecting the GPS receiver to the DF Processor Unit, youwill automaticallysee the GPS
Cursor on the Map, and the GPS information will flow into the GPS module without any further
configuration requirements. Whenusing this configuration, it is recommended youcheck that the
GPS COM Port is disabled. As you don't want HuntMaster to open an unused COM Port. To
disable HuntMaster's GPS COM Port, you should enter the 'Tools' menu, and from the 'Options'
form select the 'Position' tab. Check that the 'Use GPS COM Port' option is disabled.

ENABLING GPS TRACK LINE DISPLAY

If the 'GPS Track' option (found in the 'Map' Menu) is checked, then a GPS track line will be
displayed (if GPS connection is available). HuntMaster will plot the actual GPS position of the
Local DF Station (Station ID #0) on the Map. The track line will record the last 250 points
received. This option is available by default at program start up.

CLEARING GPS TRACK LINE

Under certain circumstances, it is necessary to clear the GPS Track Line. For instance, when
travelling from a mission location to another, the user maywant to clear the route from one spotto
the other. To clear the GPS track the user should select the 'Clear track' option located in the
'Map' Menu.
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SECTION VI - MAP MODULE

A. OVERVIEW

This software module is the heart section of HuntMaster Suit. This form plots an actual map (or
satellite image) of the region where the DF Mission is taking place. Overlaying to it a series of
marks, indications and estimators to help the DF Operator in his job of locating an RF Signal
Source. First we are going to take a look at the Map Module in its default state at startup.

WHEN THE MAP MODULE STARTS UP

When HuntMaster starts, the Map Module will perform the following two features:

· Auto Display of Base Map: At startup, a Base Map will be automatically loaded into the
Map Module. By default, HuntMaster automatically loads a World Map called
'TheWorld.map'. This map is a low resolution map of the entire globe that is installed
together withHuntMaster. If the user considers convenient for HuntMaster to statup witha
map of a specific regionof the world, then this canbe configured from the Tools > Options
> 'Map' configurationTab. Under 'Base Map' the user canselect HuntMaster's defaultmap
to conveniently choose a map of his particular country / area of interest.

· Coverage Area Display: All maps found on the '\Maps' subfolder will be displayed as
red boxes on the globe map. Indeed, the reason to display a map of the entire world at
startup is for the user to see what maps are available to HuntMaster.

As can be seen, once HuntMaster boots up, the user can easily select the map that best fits its
needs. Just by pressing "D" while clicking over their city/country of interest the user will quickly
open a higher resolution map of that region. Of course, if a map is available of that particular
location. This is why the Coverage Area Display is so useful at startup.
The default look of the Map Module is seen below. More and more rectangles will be visible as
the user fills the '\Maps' subfolder with appropriate map files of different locations of the world.
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NOTE: Although HuntMaster loads by default the above map at startup, when the first GPS
Data Packet is received , HuntMaster will try to load the Highest Resolution Map available for
the user's current location. So the user should take into account that when a GPS is connected
to HuntMaster, the above map could probably be loaded for a second, and then replaced
automatically by a higher resolution map centered in the actual location.

OBJECTS FOUND ON THE MAP DURING A MISSION

The user will have the possibility to plot and see a series of tools whichare most needed ina DF
Mapping Software. The most important features found on the map are seen and commented
below:
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· Vehicle's Location: A airplane icon is displayed in the current position of the vehicle
(GPS Derived). The iconhas the same heading of the vehicle (with respect to True North).

· GPS track: As the vehicle moves on the map, a GPS trail line is ploted. Displaying the
route the vehicle has taken.

· Landmarks (Fixed Waypoints): 'Fixed' Waypoints can be loaded from a .wpt file into
HuntMaster. This files could contain special interest landmarks, such as the position of
knownrepeaters, or fixed beacons whichcanbe used to calibrate the equipment or other
usefull information for navigation or DF'ing.

· Bearing Lines: The user can plot some of the measurements taken by the DF
Processor. This measurements will appear as 'Mobil' Waypoints (as they are DF
measurements not landmarks). This type of waypoints has the ability to displaya bearing
line in the angle of the DF measurement. When this lines intersect HuntMaster will indicate
the intersection location with a Star Icon. This is a graphical displayof the triangulationof
the last two measurements ploted on the map. A more advanced triangulation tool (usefull
when more than two bearing lines are present) is the MLPR Probabilistic Model.

· Maximum Likelihood Probability Region (MLPR) Display: This transparent layer will
show a colored region where the hidden RF Source is most likely to be located.
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To have more information regarding map coordinates, and how to create a map from a standard
image file, please refer to the 'Maps' chapter. As the module has a Map CalibrationFeature that
allows the user to generate a map from an image file. Creating it's respective ‘.map’ file.

MAP COORDINATE DISPLAY

There are several features related with the Lat / LonCoordinates Display that's found on the Map
Module. ByRight Clicking the Lat/LonCoordinates Display the user will have access to thesame
options as those found on the 'Map' drop-down Menu.

Depending on the context, the 'Map Coordinate Display' can have various different sources of
data. It is important for the user to identify correctly whichdata source is beenused inanygiven
occasion. To help identify each source, the Geographoc Coordinates displayed have an
appended caption indicating the source. The possible options for these captions are:

· It can have a 'MAP' legend if it is displaying the coordinates of the spot been clicked by
the mouse pointer.

· It can read 'GPS' if it is displaying the GPS derived possition.

· It will read 'USER' if manual Lat / Lon coordinates where entered by the user.

· It will read 'LOG' if it is displaying the logged coordinates from a .hm Hunt File.

B. BASIC OPERATION

OPENING A MAP BY ITS NAME (Manual Map Loading)

To open a specific map, the user should select the 'Open Georeferenced Map (*.map)' option
from the 'File' menu. We assume the user has one or more georeferenced maps in the '\Maps'
subfolder. If not, please refer to 'Maps' chapter for informationonhow to create a georeferenced
map from an image file.
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Once the map is loaded, the user will see it on the Map Module. The maps are opened at FULL
window size zoom (no matter what scale is the map in). The exact zoom level used is found at the
top of the Map Module. Zoom distance is expressed in radius values (in the vertical axis). So the
total distance from top to bottom of the viewing screen is double the zoom value. The
horizontal/vertical map window ratio is 1.28. Therefore the maximum horizontal distancebetween
the leftmost and rightmost points of the view should normaly be two times the zoom distance
times 1.28.

You can now load a .wpt file containing waypoint information of the loaded map area. This
additional information can be sometimes useful to identify peculiar landmarks or certain fixed
beaconsites (suchas repeaters or radio transmitters) that canbe used to corroborate thesystem
bearing accuracy before operating the system. This files can also include 'Mobil' waypoints
(althoughHuntMaster reserves this waypoints to be exclusivelyused for radiogoneometrybearing
measurements). Therefore, it is suggested to save the waypoint files after each job so that all the
historical information about each measurements is recorded for further analysis (this is also
automatically done by the Hunting Mode thru the .hm hunt files).

PANNING MODES

Once the map and its waypoints are loaded, it is important to be familiar with the different
methods that are available of navigating through it:

· Using the keyboard: The user canmove the map inanyof the four directionwitha step
size of 1/6 screen size. He can also zoom in/out in 20% steps at a time. This is done by
pressing Ctrl-I (up), Ctrl-K (down), Ctrl-J (left) and Ctrl-L (right). Or zooming using the Ctrl-
PgUp (Zoom In 20%) or Ctrl-PgDn (Zoom Out 20%). For a complete list of shortcuts
please refer to the section 'Shortcuts' of this Manual.

· Automatically with AutoPan: When Autopan mode is enabled the map will track the
vehicles motion if a GPS data source is available (GPS connected to RDF Unit, or to PC
COM Port). To enable the autopan mode press the 'Autopan' button from the toolbar (it
has toggle action). To select the threshold distance to the center of the viewing area
necessary to trigger the map repositioning, select 'Options' from the 'Tool' menu. Then
select the 'Map' tab where the user will find the percentage radius that triggers a map
redraw. The distance from the center of the viewing window to the actual position of the
vehicle is divided by the radius of an imaginary circle that has exactly the height of the
map window area. When this ratio is higher than the one set in the 'Map' tab, thena map
redraw is triggered. A value of 100% will make the autopanredraw just when the vehicle
reaches the perimeter of this imaginarycircle. While a value of 0 will make the autopan to
redraw at all times. Keep inmind that selecting very low values will increase unnecessarily
CPU processing power, as it will require to redraw the map excessively. Each time the
map is redrawn(due to movements or changes in its scale) the MLPR display is cleared,
therefore if the Autopan is constantly redrawing the map you will have to constantly
recalculate the MLPR display (pressing Ctrl-R), increasing even more the CPU
processing needs.
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C. WORKING WITH MULTIPLE MAPS

3.1 - OVERVIEW

There are several built in features to make navigating thru the available map resources as easy
as touching a key. In most cases HuntMaster can auto select the proper map to use from the
respoitory of maps available (that should be stored in the "\Maps" sub-folder). HuntMaster map
selectioncanbe diferentiated whenyouare ona mission (GPS Informationcomming in) or when
you are at the office navigating thru maps off-line (no GPS data available). Let's examine each
case next.

3.2 - MAP NAVIGATION WITH GPS CONNECTION

This scenario is normally found when the user is under a Hunt Mission. In this case, the AutoPan
feature together with the Auto Map Switch feature make map selectiona totallyautomatic task.
HuntMaster will select the Lowest Resolution Map available (widest area coverage).

· 3.2.1 - Auto Map Switch Mode: WhenHuntMaster is executed and it first receives GPS
information, it will open the map with the SMALLEST resolution when Auto Switching
between maps is enabled (default setting at startup). The zoom level at which the map is
opened is to display the whole map inHuntMaster's Map Window. The Auto Map Switch,
when enabled, automatically selects a map of the spot where the GPS is located.
Therefore, the user does not need to open maps manually by name, as the Auto Map
Switchchooses the map for you! This feature is enabled bydefault, nevertheless it canbe
disabled from: Map > "Map Auto Switch". On the Map Window there is also a shortcut to
this control (located in the middle of the 4 Manual Map Loading Arrows).

Note: When Auto Switching between maps HuntMaster selects the map with the most
similar resolution, and the same zoom level than the previous map opened. This
minimized operator's confusion when jumping from one map into another.

· 3.2.2 - Selecting different resolution maps of the same area: A pair of buttons labeld
'Higher Resolution' / 'Lower Resolution' are used to select different resolutionmaps of a
certain area. When pressing this buttons HuntMaster will locate a proper map with
higher/lower resolutionof the spot where the vehicle is located (if different resolutionmaps
of the same region are available in the "\Maps" sub-folder). If no map is found, this will be
reported in the Status Line. There is also a "Resolution" Meter that indicates the actual
resolution of the loaded map. The resolution is measured in pixels per kilometer of
latitude. As anexample, a map witha resoutionof 1000 pixels per kilometer means thatin
the North-South direction the map has one pixel per meter.

· 3.2.3 - Manual Contigous Map Switching: If the user want's to select a map from a
different location, thenhe canuse the 'Manual Map Switch' feature. This is something that
the user maywant to do if the triangulation region is located outside the loaded map. This
canhappenwhen the vehicle is far away from the target been tracked. Bypressing one of
the North/South/West/East Arrows, a contiguous map canbe loaded. Each time the user
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uses the 'Manual Map Switch' feature HuntMaster will automaticallydisable the 'AutoMap
Switch'. The new map been loaded, is zoomed at the level of the previous map to make
the transition as smooth as possible to the operator.

· 3.2.4 - Loading the highest resolution map of any place clicked: To opena mapofa
currently blank area, or to display the HIGHEST Resolution Map of a certain spot on the
loaded map, the user canpress the "D" keywhile pressing this keyclicking left clickingon
the location of interest. A cross is drawn at this location, and HuntMaster asumes this is
the simulated GPS derived vehicle locationwhere the user wants to focus his maps from
now on. .

Note: When you open a new map using this feature, the Auto Map Switch feature is
disabled. As GPS information could make the newloaded map to unload, and get back
to the previous map been displayed.

3.3 - MAP NAVIGATION WITHOUT GPS CONNECTION

This scenario is normally found whennavigating thrumaps at the office withno GPS connection.
In this case, HuntMaster does not know the exact location where the user is willing to focus his
attention. Basically there are three ways inwhich the user can let HuntMaster know what location
he wants to concentrate in:

· Default: If no information is provided to HuntMaster, then it asumes the user want's to
focus in the center of the viewed map.

· Pointing on the map: If the user selects a spot on the map (by pressing the "D" key
while he clicks on a certain location on the map), then a cross is drawn at this location,
and HuntMaster asumes this is the simulated GPS derived vehicle locationwhere theuser
wants to focus his maps from now on.

· Geographic Coordinates: By left clicking the Lat/LonCoordinates in the Map Window,
the user canhave access to the 'Manual Coordinates Entry' Window. This popup givesthe
user the possiblityof entering a location (based onLat / LonCoordinates). HuntMasterwill
process this coordinates as if it was GPS information. It will first tryopening the maximum
resolution map of that location. The new geographic coordinates will be displayed in the
Map Window, followed by the legend 'USER'.

Once the location is determined, then there are differents ways to operate HuntMaster to select
different maps of a certain spot while no GPS is present:

· 3.3.1 - Loading the highest resolution map of any place clicked: To opena mapofa
currently blank area, or to display the HIGHEST Resolution Map of a certain spot on the
loaded map, the user can press the "D" key and while pressing this key clicking left
clicking on the location of interest. A cross is drawn at this location, and HuntMaster
asumes this is the simulated GPS derived vehicle locationwhere the user wants to focus
his maps from now on. .
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Note: When you open a new map using this feature, the Auto Map Switch feature is
disabled. As GPS information could make the newloaded map to unload, and get back
to the previous map been displayed.

· 3.3.2 - Selecting different resolution maps of the same area: A pair of buttons labeld
'Higher Resolution' / 'Lower Resolution' are used to select different resolutionmaps of a
certain area. When pressing this buttons HuntMaster will locate a proper map with
higher/lower resolutionof the spot where the user has positioned the cross (thrupressing
"D" plus left mouse clicking). If not, the center of the screen is used as the spot to focuson.
If different resolution maps of the same region are available in the "\Maps" sub-folder,
HuntMaster selects the proper one. If no maching map is found, this will be reported in the
Status Line. There is also a "Resolution" Meter that indicates the actual resolutionof the
loaded map. The resolution is measured in pixels per kilometer of latitude. As an
example, a map with a resoution of 1000 pixels per kilometer means that in the North-
South direction the map has one pixel per meter.

· 3.3.3 - Manual Contigous Map Switching: If the user want's to select a map from a
different location, thenhe canuse the 'Manual Map Switch' feature. This is something that
the user maywant to do if the triangulation region is located outside the loaded map. This
canhappenwhen the vehicle is far away from the target been tracked. Bypressing one of
the North/South/West/East Arrows, a contiguous map canbe loaded. Each time the user
uses the 'Manual Map Switch' feature HuntMaster will automaticallydisable the 'AutoMap
Switch'. The new map been loaded, is zoomed at the level of the previous map to make
the transition as smooth as possible to the operator.

3.4 - MAPS COVERAGE DISPLAY

HuntMaster canplot map coverage of eachof all available maps found in "\Maps" sub-folder. To
display this information the user should press the Ctrl + "M" shortcut. Bydoing this, he will see a
series of rectangles eachof them indicating the coverage area of eachmap. To opena particular
map, just proceed as in3.2.4 or 3.3.1. Doing that procedure will open the highest resolutionmap
of the area. If the operator prefers a smaller (less resolution map, the Lower Resolution Button
should be used).
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3.5 - INTELIZOOM

HuntMaster has context sensitive map opening zoom levels. To make operation as smooth as
possible, each time HuntMaster opens the Base Map at startup, it does it at FULL window size
zoom. If the user opens a map manually (from the 'Open' option found in the 'File Menu' ), then the
map is also opened at full window size zoom. Nevertheless, whena new map is loaded thru the
Auto Map Switch, or the Contigous Map Switch options, then maps are opened at the same
zoom level than the previous loaded map to make the transition as smooth as possible to the
operator.

D. WORKING WITH WAYPOINTS & BEARING LINES ON THE MAP

Now that we have learned how to load and pan the map, we need to be able to show bearing
measurements. Both from the DF Unit or from manually taken bearings (using directional
antennas). To do so, the Map module has a special tool to create what are called 'Mobile'
waypoints. This waypoints have the special feature of displaying a bearing line on the map. The
user canalso manipulate them easily, modifying, hiddening, or evendeleting them. The user has
various ways to create one of this waypoints, depending on the source of the information.

The standard method for plotting a measurement on the map is to press the Ctrl+F3 shortcut, or
press the "World Icon Image with two DF Bearing Lines on it" found in the TouchScreenButtons
Panel. Using this method, HuntMaster uses the Mode angle information generate the
corresponding bearing line on the GPS derived location. This method also has an Auto
Persistence Clearing Feature of the Radar Display, which is necessary to prepare the Radar
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Mode calcuations for the next measurements to plot.

ADVANCED PLOTTING OF BEARING MEASUREMENTS

For advanced users who mayneed to operate HuntMaster under different scenarios, additional
options are availalble to efficiently plot bearing lines on the map.

· Manual/External DF Entry Window: If going to displaya manual bearing Ctrl-F1should
be pressed. The following form will pop-up:

· 

· This feature enables the DF Operator to enter the exact coordinates of a remote SIGINT
(Signal Inteligence) DF Station. The user will have to enter the bearing angle referred to
the North of the remote DF Station. This angle is what's measured on a magnetic
compass mounted to the mast of a directional antenna (and has beencompensated for
magnetic declination). Notice if the Quick MLPR actualization is enabled, then if a MLPR
is been displayed this measurement will be added to the previous probability
computations. To change this configuration select 'Option' from the 'Tool' menu. Then
select the Map tab, there you will find the default setting of the Quick MLPR Display
actualization. This entrymode has no touch-screenbutton, as the DF Operator will haveto
use the keyboard to select the coordinates and bearing angles.

· DF Mode Angle Entry Window: If the user wants to create a Mobile waypoint with the
Mode Angle calculated by the Radar Module (based on local DF Stationbearings), then
the Ctrl-F2 shortcut should be pressed. The following form will appear:

· 

· It is very similar to the previous one, except for the fact that the bearing information is
already loaded with the Mode angle calculated by the Radar module. It canbe seen that
this bearing is not in absolute degrees North, but it is measured from the vehicles
heading. Therefore, the travelling directionof the vehicle is needed to correctlydisplaythe
measurement on the map. This information is obtained from the Digital Compass
connected to the DF Unit, or if not available from the GPS receiver's data. Keep inmind
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that if using GPS derived Heading then the the vehicle should be in motion (and in an
aproximately straight line) for the GPS Heading to be accurate. As stated before, the
Quick MLPR setting of the 'Options' form will dictate the way the MLPR display will be
updated (or not). .

This input method is very similar to the Ctrl+F3. The difference is that this mode allows
the DF Operator to trim the Mode Value, and Vehicle's Heading. It does not Clear the
Persistence of the Radar display. Except for special purposes, the user is suggested to
use Ctrl-F3 instead of this entry method.

· Visual DF Bearing Plotting: The last method is usefull when the user is using the Map
Module with no GPS receiver or DF Unit attached. Under this circumstances, the user
should press the 'Insert WP' toggle button located at the toolbar. When this option is
enabled, a waypoint canbe created bydouble clicking onanyplace on the map. A pop-up
window will prompt to enter the manual bearing measurement. The user should once
again keep in mind that he should first compensate the measurement for magnetic
declination before entering the angle.

CREATING FIXED WAYPOINTS

The main difference between a Fixed Waypoint and a Mobile one is that the first one has no
bearing angle asociated with it. There are two ways to create a Fixed Waypoint. The most
convenient method depends on what information the user has available about the landmark to
locate:

· If geographic coordinates are known: If the latitude and longitude of the landmark is
known, then the best way to create a fixed waypoint with this information is byopening the
'Waypoint Editor' located in the 'Map' menu. The user will find there an 'Add' button that
allows add a new waypoint byentering its coordinates. The Name and Descriptionof the
fixed waypoint can also be entered in a similar way.

· If geographic coordinates are not known: If the coordinates of the landmark are
unknown, but its locationcanbe visualydetermined on the map, thenproceed as follows:
press the 'Insert WP' toggle button located at the toolbar. When this option is enabled, a
double click of the mouse on any place of the map will create a waypoint. A pop-up
window will prompt to enter the manual bearing measurement. If you leave it blank and
confirm (bypressing the 'Ok' buttonor bypressing the Enter key) a Fixed waypoint will be
created. To change its Name or Description you may disable the 'Insert WP' mode, and
double click the new waypoint. You will have an option to edit it.
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MANIPULATING WAYPOINTS

The Map module has a list of loaded waypoints, whichcanbe viewed byselecting the 'Waypoints
Editor' option from the 'Map' Menu:

As you can see, all the informationof anygivenwaypoint canbe browsed, and a givenwaypoint
canbe edited. From this form it is also possible to delete a selected waypoint, and manuallyadd
new waypoints. This last option is mainlyused to create 'Fixed' landmarks waypoints (whichcan
be saved, and then loaded at hunt time). To add a new waypoint using this option the user must
know the exact coordinates of the landmark he is going to highlight. If this information is not
available, then first look at its coordinates by locating the mouse cursor over the landmark while
pressing the left mouse button (or proceed to an alternative method as suggested above). The
coordinates will appear on the top of the Map module window. Then from the Waypoints Editor
add a new waypoint with this coordinates.

DELETING WAYPOINTS

There are several ways to delete a Waypoint (both Mobile or Fixed). Options are:

· Single Waypoint deletion by clicking the Object on the Map: Whendouble-clickinga
Waypoint, the InformationWindow will pop-up. This window has a 'Delete' buttonwhichwill
erase the object.

· Single Waypoint deletion by selecting the Object in the Waypoint Editor: Selecting
the 'Waypoints Editor' option from the 'Map' Menu the user will see the complete list of
Waypoints loaded. The user can select any of these objects based on its Name,
Description, Date & Time Stamp, or any other additional field. After selecting which
waypoint to erase, the user should press the 'Delete' button to erase it.

· Batch Waypoint deletion by type/age: HuntMaster has a powerfull Waypoint deletion
tool that's found in the 'Map' Menu under 'Delete Waypoints...'. A pop-up window will be
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displayed prompting which rule to use to erase Waypoints. Options are: To delete Mobile
Waypointes (Plotted Bearing Lines) or Fixed (Landmarks). When doing a mission it is
sometimes usefull to delete older waypoints based on age. If the vehicle is approaching
the target transmission, then it is important to hide (erase) the older Bearing Lines, not to
confuse the DF Operator. To do this, simply choose 'Mobile Waypoints' and select the
maximum age allowed to keep the Bearing Lines. .

There is also a keyboard shortcut feature to selectively erase all Mobile Waypoints
(Bearing Lines) which are older than a certain amount of minutes. A set of 3 different
keyboard shortcuts erase all bearing lines older than 5/10/15 minutes. Using shortcut
Ctrl+F8 all Mobile Waypoints older than 5 minutes are erased. Ina smiliar way, pressing
Ctrl+F9 erases all Bearing Lines older than 10 minutes. Finally, bypressing Ctrl+F10 all
Mobile Waypoints older than 15 minutes are deleted.

· Bearing AutoErase Feature: This feature automatically erases older Bearing Lines
keeping just a certain number of measurements visible at all times. The AutoErase Wpt
operates while the Hunting mode is enabled AND while playing back a .hm file. If a Hunt is
underway, then the AutoErase feature will be active. If the Hunt is Paused or Stopped,then
the AutoErase feature will be disabled. In a similar way, the AutoErase feature will be
active while playing back a mission file. Therefore, if you are playing back a mission the
user will see ONLY the amount of Mobile Waypoints that you have configured to show.
During mission playback if you move the slider back (to a previous moment in time) the
user will see all waypoints in the .hm file for an instant. The waypoints in excess will be
then erased a moment later. To configure the maximum amount of Mobile Waypoints the
user wants to keep, please refer to Tools > Options > Map > "AutoErase Mobile
Waypoints" section. .

NOTE: Please remember that this feature is only active while Hunting.

WAYPOINT NAVIGATION INFORMATION WINDOW

This feature allows the user to have specific information related to the Fixed Waypoints plottedon
the Map. When the WpyNav toggle button (located on the top ToolBar) is activated, it will pop-up
the Waypoint Navigation Information Window, which will:

mailto:info@HuntMaster.com.ar
http://www.HuntMaster.com.ar


info@HuntMaster.com.ar - Copyright © 2008 by HuntMaster Corp - www.HuntMaster.com.ar

 42 of 66 - Operator’s Manual - HuntMaster Corp.

a- Displays the NAMES of all landmarks (FIXED waypoints) located on the map, next to the
icon indicating their location.

b- The Waypoint Navigation Information Window will become active. All landmark (FIXED
waypoint) will be displayed there ordered by shortest distance from the actual location
(GPS derived). The bearing the vehicle should take to go to that landmark location, and
the distance to reach destination are also displayed for each landmark.

c- If the user left clicks on a certain location of the map, then the above custom window will
give the distance and bearing angle from each landmark to that specific locationclicked
by the operator. Once the operator depresses the mouse button, the window will use the
GPS location to recalcualte all Bearings and Distances.

d- If the WptNav button is disabled, all the above information will be hidden. The WptNav
button has toggle action.

This WptNav feature helps navigation using the Landmarks (FIXED Waypoints) loaded on the
map. The Waypoint Navigation Information Window is updated with each GPS data reception.

OBTAINING INFORMATION FROM ANY WAYPOINT SEEN ON THE MAP

HuntMaster has a 'Waypoint Info' window that shows all the information available of a certain
Waypoint. This window will look similar to this one:
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There are two ways in which the user can prompt for information of specific waypoints seenon
the screen. Both methods, will make the 'Waypoint Info' window to pop-up:

· For an Individual Waypoint: Bydouble clicking with the mouse ona waypoint will make
the 'Waypoint Info' window to pop-up displaying all available informationof that Waypoint.

· Browsing Multiple Waypoints: By pressing the Left Mouse Button while moving the
mouse cursor on the map, the user canselect anyWaypoint he is interested in. Each time
the cursor goes over a Waypoint, the 'Waypoint Info' window will be updated with the
particular information for that Waypoint. The 'Waypoint Info' window closes automatically
when the user depressed the Left Mouse Button.

E. HUNTING MODE & LOGGER

The usefulness of a Hunting mode ina DF Mapping applicationare multiple. First if HuntMasteris
awared of what the user is doing, he canreconfigure itself best to help the DF Operator efficiently.
Second, the Hunt Log generates valuable information for later analisys, as anentire DF Mission
could be latter on reviewed. Searching for procedural mistakes, erroneous or misleading pieces
of information, and so on. A Hunt Log is an incredible tool to improve your staff DF skills, and
share experiences withother DF Operators. Sharing Hunt Files withother DF teams provestobe
very useful to learn from each others experiences.

When the Hunt mode is active the following functionality is available:

· The Maps been used by the user are logged.

· If a GPS receiver signal source is available, thenHuntMaster will log the GPS track trailon
the Hunt file every 5 seconds. While it keeps the last 250 track points visible. If altitude
information is available, this will also be stored in the file.
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· All bearings plotted by the DF Operator (bothuser ploted measurements and AutoPloted
measurements) will be logged into the hunt log file, together with DF Bearing Quality
information.

· If 'Bearing AutoPlot' mode is configured (Tools > Options > 'Map' tab), then automatic
measurements will be plotted on the map while the Hunting mode is enabled.

· If the 'AutoErase Mobile Waypoints' mode is configured (Tools > Options > 'Map' tab),
then only the last bearing lines will be visible on the map, as older Bearing Lines will be
automatically erased.

The user mayalso be interested inactivating the 'AutoPan' feature. As this will automaticallypan
the map so that the vehicle will remain near the center of the map

HUNT FILES (.HM) NAME OPTIONS

There are two operating modes for the selectionof the file name of the (.hm) Hunt Log File. Let's
see the logic behind each option:

· Fixed File Name: If the user clears the 'Append Data Stamp to Log File Name' checkbox
(found in the Tools > Options > 'Map' tab) then, the Hunt File will have the name defined in
the 'Hunt Log File (.hm)' field, located in the same configuration tab. If the user sets a fixed
name for a Hunt File, then HuntMaster will save all Hunt information in the same file. If the
file already exists, you can choose to overwrite the previous file.

· File Name with Date & Time Suffix: By checking the 'Append Data Stamp to Log File
Name' checkbox (found in the Tools > Options > 'Map' tab) the Hunt File will have the
name defined in the 'Hunt Log File (.hm)' field plus a suffix formed by the Date and Time
Stamp. So each time you trigger a Start Hunt a new file is generated automatically, and
with a different name. This is the suggested method of operation.

Note: All (.hm) Hunt Files are stored by default in a subfolder called '\Hunt'. This makes it very
simple to find them in the event the user wants to copy this files to share them with other DF
Users. To learn more about the logger file format, please refer to 'Advanced User Information'
section of this Manual.

STARTING / PAUSING / ENDING A DF MISSION FILE

A Hunt Button is conveniently located in HuntMaster's Toolbar. By pressing this toggle buttona
new Hunt canbe Started, a Hunt canbe Paused, and latter onResumed. To End the Hunt (which
is something the user does just once, and when the missionhas ended) the DF Operator should
go to the Menu: Hunting > "End Hunt". Note that if the user does not end the hunt before closing
HuntMaster, the program does end the hunt automatically before closing.
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When the Hunt Button is in the Paused mode, it is indicated by a 'Rec Icon' which blinks in
Yellow/Red, while the button changes its caption from 'Hunting' to 'Paused' every 500mS. This
helps the operator not to forget the Hunt Paused when action is taking place.

Remember to exit from the Hunting mode once you finish the mission. This will stop file logging,
and will properlyclose the Hunt File. In this file youwill have the complete historyof operation,with
periodical measures (every5 seconds) of GPS Latitude, Longitude, Code, Altitude, Time&Date
Stamp, DF Bearing, Radar Mode Angle, DF Hold Status, Mute, DF Bearing Quality, GPSSpeed,
Digital Compass (or GPS Heading if no Digital Compass is available).

Please take into account that to have GPS Altitude, Speed and Heading information the GPS
receiver has to be directly connected to one of the computer's COM Ports. When the GPS
receiver is connected to the DF Unit, only Latitude and Longitude information is retrieved.

BEARING AUTOPLOT FEATURE

This automatic bearing plot mode places bearing lines on the map without user interventionwhen

· A certain time has elapsed (time trigger)

· A certain distance has elapsed (distance trigger)

The amount of bearing lines automaticallydisplayed are also user configurable. So that bearing
lines don’t increase indefinitely. Those automatic bearings, as all bearings will be plotted on the
exact GPS derived location, and will use the Digital Compass heading information for computing
the true northabsolute bearing to be displayed on the map. In the DescriptionField of the Mobile
Waypoints generated automatically will read: "AutoPlot Measurement" for the user to know that
this has been an automatic generated waypoint.

The new AutoPlot feature is enabled/disabled together with the Hunt Toggle button. When the
Hunt is underway, then the AutoPlot feature will be active. If the Hunt is Paused or Stopped, then
the AutoPlot feature will be disabled.

To configure the Time / Distance Trigger of the AutoPlot, please refer to Tools > Options > Map>
"Bearing AutoPlot" section. The Data Source canbe selected betweenplainDOA data (the raw
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data received from the DFP-1000B unit), or the Statistical Mode integrated over the time period
elapsed between the last measurement has taken place. I recommend you use the Mode Data
Source option at al times, except when you are very near the target (signal source) and the
Bearing Line Angle is not constant, but increasing/decreasing rapidly.

BEARING AUTOERASE FEATURE

This feature automatically erases older Bearing Lines keeping just a certain number of
measurements visible at all times. The AutoErase Wpt operates while the Hunting mode is
enabled AND while playing back a .hm file. If a Hunt is underway, then the AutoErase feature will
be active. If the Hunt is Paused or Stopped, then the AutoErase feature will be disabled. In a
similar way, the AutoErase feature will be active while playing back a mission file. Therefore, if
you are playing back a mission the user will see ONLYthe amount of Mobile Waypoints that you
have configured to show. During mission playback if you move the slider back (to a previous
moment in time) the user will see all waypoints in the .hm file for an instant. The waypoints in
excess will be then erased a moment later. To configure the maximum amount of Mobile
Waypoints the user wants to keep, please refer to Tools > Options > Map > "AutoErase Mobile
Waypoints" section.

NOTE: Please remember that this feature is only active while Hunting.

AUTOPLOTTING GPS SYNCED DOA MEASUREMENT (Advanced User Information)

For users that are going to deploy a Mobile DF Station on a very high speed vehicle, it maybe
important to synchronize the DF measurements with the instant where the latest GPS Position is
available. HuntMaster has provisionof this feature. This minimizes measurements errores in the
case where:

1- The user is operating with a Local DF Unit

2- The Bearing AutoPlot Mode is enabled

3- It is using DOA Source DF Data

4- The DF Station is travelling at very high speeds (> 500Km/h)

When the above circumstances happen, it is important to have GPS Synced Measurements.Asa
ultrasonic airplane travelling at 2000Km will travel 0.3Km in between two GPS consecutive
updates. To decrease this sampling error to zero, thenHuntMaster reads the DOA Bearing atthe
instant when the GPS Position is updated. Avoiding the localizationerror between the timeDFP-
1000B computes a bearing line and the exact place where the vehicle was at the time.
Correlation between GPS position and DF bearing information has been implemented byonly
reading the first DFP-1000B Bearing Angle after each GPS $GPGGA Packet (Global
Positioning System Fix Data Packet). This wayHuntMaster canwarrantee absolute correlation
between both sources of information that are going to be plotted on the map. All measurements
that have been plotted in GPS Sync mode have the following Waypoint Description: "AutoPlot
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Meas. (GPS Sync)".

The above GPS Sync algorithm only works when the user has enabled the Bearing AutoPlot
feature, with the DOA Source selected. The GPS Sync Measurements has only been
implemented in the AutoPlot mode, as the other manual methods to display Bearing Lines use
the Mode instead of the plain DOA data. When using the Mode, it is not important to have GPS
Synced Measurements, as the Mode is computed thrua comparably long interval of time(dozens
of seconds) therefore the latest GPS Position Updates is not important.

F. PLAYING BACK A HUNT FILE

OPENING A (.HM) HUNT FILE

To playback a (.hm) Hunt File, the user should select the 'Play' option found in the 'Hunting' Menu.
A pop-up window for selecting the Hunt File to retrieve will appear. Once the file is selected,
HuntMaster will open the necessary Map files, and will display the GPS track and show all the
Bearing Lines taken during that particular DF Mission.

HUNT PLAYBACK CONTROLLER

HuntMaster Ver. 5.1.8 onwards has support for Ver. 2.0 Logger Engine Files. This enhanced
recorder/playback module is muchmore powerfull thanbefore. The user cannow set thespeedat
which the .hm Hunt File is played back. Using a time line slider control the user canmove back
and forth in time to see the exact moment where something took place. This playback control
looks similar to an MP3 audio playback window to be as user friendly as possible.

The 'Hunt Play Controller' has a checkbox to select 'Open Maps in (.hm) file'. By default this
options is checked, forcing HuntMaster to open the same map files that the DF Operator used in
each precise moment in the Mission. There are moments, when the user may want to select a
different map, or a better map that was not available at the time the Hunt File was recorded. By
unchecking this option, HuntMaster will cease to open any map files recorded in the (.hm) Hunt
File. The user can then use the 'Auto Map Switch' feature, or anyother option to opena different
map while playing back the Hunt File.
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LEGACY COMPATIBILITY WITH VERSION 1.0 LOGGER FILES

New Ver 2.0 (.hm) Hunt Files are no longer compatible witholder 1.x files. Therefore, HuntMaster
will play older files in the older fashion (no Playback Controller will appear), while providing
improved features onlywhennewly recorded (.hm) Hunt Files are used. The new (.hm) Hunt Files
record multiple map changes, while also having provision for multi DF Station tracking. The new
file format is capable to track and show DF Measurements of up to 5 different DF stations.
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SECTION VII - TRACKING DOWN THE SIGNAL

A. RDF BASIS

1. INTRODUCTION TO RDF TECHNOLOGY

When a new user comes to operate a RDF System for the first time, he may feel that the unit is
not operating properly. This first feel is normal, as Radio Waves are not like laser beams. Radio
signals reflect in objects (mountains, buildings) ina similar wayas sound reflects inobjects. You
probably have heard the sound of anairplane approaching and believed that it was coming one
way, while the aircraft was approaching from exactly the opposite direction! Well, the sameistrue
with radio waves; they reflect. Indeed, there are cases where you will have a bearing in the
opposite direction from where the transmitter is located. In a newcomers own words:

"I have an area where I move the vehicle 40 yards and the signal comes from a different angle
and the signal strength drops. I move halfway and the signal is still strong, but is off by about20
to 30 degrees"

Those scenarios are just normal, bearing directiondiscrepancies are always present. There are
ways to mitigate this multipath generated errors, as we will discuss throughout this chapter.

2. ABOUT HOW TO INTERPRET THE DF DISPLAY'S DATA

Of course all those reflections and bearings that move +/- 45 or more degrees canbe filtered. If
not, DF operation would be impossible. The clues a DF Operator uses to avoided using
erroneous data are:

· 2.1. Temporal: Reflections tend to be displayed as short bursts in DefCon2b & DFP-
1000B bearing display.

· 2.2. Quality: Reflections tend to give less quality measurements (shorter vectors).

· 2.3. Statistical: The correct bearing angle tend to be more recurrent than any other
direction in the bearing display.

The above clues are seen both in DefCon2b's & DFP-1000B bearing displays and have to be
evaluated subjectively by the operator. Once he gets used to looking at these displays, he will
perform steps #2.1 thru #2.3 without even noticing it. As stated in 'RDF Products' Web Notes:

"The highly dynamic nature of mobile DF applications is such that considerable judgement is
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often required to differentiate a valid bearing from erroneous ones induced by noise and
reflections. Inexpensive bearing displays such as mechanical pointers and LED rings are
extremely difficult to interpret under such conditions. Numeric bearing displays are almost
useless. In contrast, the RDF Products Models DFP/DFR-1000B and DFR-1000B employ
real-time polar bearing displays that not only indicate the azimuth, but also indicate the quality
of the bearing in a highly unified, intuitive format. To explain, bearings induced by noise and
reflections tend to be associated with shorter display vector lengths while valid bearings tendto
be associated with longer display vector lengths. The real-time polar bearing display is thusan
enormously powerful tool for helping the operator deal with the demanding requirements of
mobile DF."

While ina mission, it is very important to see the qualityof the DF Bearings at all times. Againan
extract from 'RDF Products' Web Notes:

"As a case in point, if the operator is using the system in a tracking and homing mode, it is
important that he "ride" the Video Gain control so that the vector length always be on-screenso
that he can see the relative vector lengths (and rely upon bearings associated with longer
vector lengths as being the most reliable). Unfortunately, most inexperienced operators are
inclined to miss this subtlety and set everything to "max". (This is the reason why the bearing
vector color changes when the vector exceeds full-scale). Another case in point is that in a
mapping application, it is important that the vehicle be in motion so that multi-path can be
averaged out."

The above quotation is a rule of thumb of DF Operation. This is the reasonwhyHuntMaster has
provisionof a 'Signal QualityMuting' Control (located in the IP DF Controller window). Low quality
measurements are automaticallydiscarded. Nevertheless, this feature operates properlyONLYif
the DF Operator is riding the Video Gain (as 'RDF Products' engenieers suggests). If VideoGain
is set at maximum, both good and bad measurements are going to slip into the Radar Display
(and will eventually be used to calculate bearing lines later on).

3. MAKING SURE YOU ARE ON THE CORRECT LEAD

3.1. Taking advantage of DFP Audio listen-thru capability

Considerable effort is dedicated inDFP designs so that users could take advantage of the DFP
voice listen-thrucapability. This is a very important feature that new users generallyoverlook.Asa
good case in point, tracking weak pulsed vehicle radio beacon signals would be almost
impossible if the operator did not listen to the audio (in this case CW) so that he would know
exactly when the signal is present. Below an extract of 'RDP Products' DFR-1200B manual:

Aside from frequency selection (which is accomplished exclusively using the Radio Receiver),
the Radio Receiver and DFP-1000B are essentially parallel receivers with independent IF
bandwidth and demodulation mode selection as well as independent audio outputs.Thisallows
the user to rely on either of the two units to select reception mode and listen-through. For most
applications, we recommend that reception mode selection and listen-through be done viathe
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DFP-1000B. This simplifies operation, both from the standpoint that the DFP-1000B is easier
to operate than the Radio Receiver and that the user need pay attention to only one unit (the
DFP-1000B) for all operational matters (aside from frequency selection, which must still be
done at the Radio Receiver). Another benefit is that the DFP-1000B includes a special filter
that attenuates the DF antenna encoding tones for most signal formats, thus improving listen-
through capability.

Since most DF applications require only basic receiver feature selection (e.g., receptionmode,
IF bandwidth, and volume/squelch adjustment), this operating scheme is usually the best
choice. If the user chooses to operate the system in this fashion, then we recommend that the
Radio Receiver AGC (automatic gain control) be disabled since this results in a slight
performance advantage.

3.2.Taking advantage of DFP S-Meter capability

The truth of the matter is that a dB-linear S-meter indication is much more desirable than the
more typical S-Meter indication found on Radio Receivers (where high-signal levels are all
compressed above S9). To explain, the S-Meter indication in a mobile DF system is the
operator's best relative ranging indicator. If this indication is dB-linear, the operator has a much
better indication of relative range than if the scale is compressed at the high end.

In fact, law-enforcement users (who use mobile DFs to track radio beacons planted onsuspects'
vehicles) rely heavily on the DFP S-Meter indication to know when theyare getting veryclose to
the tracked vehicle. This would not be easy to do using a typical communicationRadio Receiver
S-Meter.

Therefore, DFP-1000B S-Meter is a much more useful ranging indicator than the one on the
Radio Receiver been used.

4. FINDING THE RIGHT PLACE TO DF

For all clues mentioned in #2 to held true, the DF vehicle has to be inmotionwhile using the DF
System. If the vehicle is not moving, then the user will loose the temporal cue, the statistical cue,
and if facing a poor qualitymeasurement there is no way the user can fight aginst it! Therefore,for
the above 3 cues to be 'visible', the DF vehicle has to be in motion while DF'ing. Nevertheless,
the vehicle is not required to travel at high speeds. With a speed of 5-10 miles anhour the user
will see these cues just fine.

Another important issue is about obstacles between the unknown transmitter and the DFAntenna
Array on the cars roof. If the DF Operator know that the unknown RF Source is (for instance)
located at mountain top. Then it is muchmore easy to have verygood DF measurements to track
them down. Just move to a nearbymountain top, and do your measurements from there.Bearings
taken from hill tops are really trustworthy. Very few measurements but taken from two different
mountain tops are much more useful than hundreds of poor quality measurements taken at a
valley (which add no useful information at all).
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5. HOW HUNTMASTER FITS IN?

HuntMaster has a novel approach to treating cues #2.1 thru #2.3. For temporal and statistical
cues, it uses the Radar Module's Mode filtering. While for the Qualitycue, it uses a muting when
the measurements have a quality factor below a certain threshold. This threshold canbe modified
from the 'IP DF Controller' window. For this qualitymuting to operate properly it is important that
the user 'rides' the Video Gain of DF Processor at all times.

For instance, if the DF Operator faces anunknown location transmissionof 50 seconds in length,
he should: Drive his DF vehicle ina straight line (at a hill top, or at anyother wide open location).
Meanwhile, during that period of time he lets the Radar Displayaccumulate measurements.Once
the transmission ends and only if he feels comfortable with the overall quality of the
measurements (based on the above 3 cues) he now proceeds to plot the bearing on the map
(Ctrl+F3 shortcut). If the user does not trust the overall qualityof the 50 seconds of measurements
taken, then he should try to move the DF vehicle to a better spot. A better spot would be a
locationwhere he could receive the signal with less reflections due to nearbyobjects obstructing
the 'line-of sight' between the DF Antenna Array and the transmitter.

6. USING HUNTMASTER'S RADAR AND PLOTTING CAPABILITIES
EFFICIENTLY

HuntMaster has some verypowerfull tools not found onother DF Mapping aplications. Therefore,
it is important for any DF Operator to take some time to learnhow to efficientlyuse the available
resource toolbox. Some poorlyconceived DF Mapping programs relyonverysimple algorithms
to plot bearing lines on the map. Indeed, some DF Users belive that a Mapping application is just
analgorithm that at the press of a buttonstart shooting directional lines at the target while moving,
displaying a cross in the intersection regionof these lines. Beenable to stop the shooting and or
clear the lines at any time.

Although the above implementation is an actually way to go (indeed most commercial DF
Software operate that way) our engenieers found that it is not the best way to go for efficient
signal localization. After several years of joint development efforts witheconometricians from the
University of Sussex (UK) we jointly developed a verysophisticated mathematical aiding tool to
track down a RF Signal. The first breakthrough in DF operation was finding an appropriate
unskewed statistical filter to clean spurious DF data. This was the statistical mode operator.
Indeed, the Radar display does just that: to calculate the statistical mode in an easy to read
graphical display. By doing so, it is possible to accurately estimate the real bearing angle.
Discarding as much noise, interference and multipath induced errors as possible.

To take the best advantage from the Radar Mode filtering, the DF Operator should acumulate as
much measurements in the Radar Module as possible before plotting a bearing line with it. Of
course, the DF Measurements have to belong to the same RF Signal Source, and the DF
Incidence Angle should remainconstant through the vehicle displacement. Once the DFOperator
considers that a proper estimation has beenachieved (seenas a veryconsistent reading in the
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Radar Screen) then he should press Ctrl-F3. This shortcut will generate a new measurement
bearing line (Mobile Waypoint), while then Clearing the Persistence of the Radar Screen.
Preparing the Radar to accumulate new measurements to estimate a new bearing line. TheCtrl+
F3 shortcut is equivalent to pressing the "World Image with two DF Bearing Lines on it" button
from the Touch Screen Buttons Panel.

If the DF Operator has modified, the DF Radio Receiver's frecuency, or a different RF Source is
now been received, then he has to start a new measurment estimation by Clearing the
Persistence of the Radar Display. He should then press the 'Clear Persistence' button (of the
Radar Screen). It can also use Ctrl-C as a shortcut. The Radar will start a new Mode estimation
with the measurements decoded from now on.

As you can see it is an easy two step process oneachmeasurement the DF Operator wants to
perform. One step to Start the data recollection in the Mode Econometric Model, and the second
step to End the process and display the result on the map.

The DF Operator should try to wait as much time as possible betweenplotting sucessive bearing
lines. DFP-1000B generates some 40 measurements per second, then, as more time elapses,
more information will be available to accuratellycalculate a Mode Bearing Angle. As a practical
rule, at least some 1000 / 2000 samples are required for a good Bearing Angle estimation. This
are approximately 30 to 60 seconds of data integration. Of course it is best if the DF Operator
canwait even longer. The practical limit to the time the DF Operator canwait betweenstartingthe
computation, and plotting the result is a matter of how much time the RF Singal Source is present,
and the Incidence Angle of that singal remains constant from the vehicles point of view.

After a couple of minutes of work, the DF Operator will have a few measurements (instead of
dozens of them if automatic plotting every 5 seconds was used in poorly conceived software
applications). But these few measurements take into account thousands of measurements that
have beenprocessed to generate those few bearing lines. Now it is possible to triangulate using
this VERY reliable Bearing Lines. We developed for this triangulation task a Homosedastic
Maximum Likelihood Probabilistic Model (MLPR) which is a veryadvanced tool to determine the
most probable region to find the originof the RF source. Evenmultiple sources on the sameradio
channel can be tracked at the same time! The display for the MLPR is a colored overlayon the
map. This areas are colored from a light yellow (minimum probability) to a dark red (maximum
probability). There are 1280 rainbow like colors to depict probability values. To activate the
MLPR (once youhave two or more Bearing Lines on the map) the DF Operator has to press Ctrl-
R. Just as easy!

7. CONCLUSION

Any new user should get introduced into RDF Technology in a step by step approach. The
milestones one would suggest to any new DF Operator are:

· 7.1. Use a knownbeacon(e.g. leave a transmitter at the office) and track it downusingthe
DF vehicle. While driving thru the city the user should take a look at DefCon2b's & DFP-
1000B's Bearing Display. To learn how to understand the cues we have already talked
about. We suggest to travel to a nearbymountain top (or clear area) and appreciate how
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measurement overall quality improves drastically compared to measurements taken
downtown. Of course, this is a quite boring exercise, as the exact location of the
transmitter is known. But it is an important step to understand the equipment.

· 7.2. Ask someone else to drive in a vehicle and park at a nearby Macy's parking lot (or
similar wide open parking lot). Ask this person to transmit periodically, while you try to
track him down with the DF vehicle.

· 7.3. Once the user gets used to dealing with DF bearing issues, now go out for a real
world mission. Suggestion would be to start by DF'ing a simple transmission in a fixed
frequency first. Tracking downa signal witha highS-Meter inidcationwould be best (start
tracking down a nearby transmitter first). If not, select a transmission you feel more
comfortable with. Once the object to locate is clearly indentified, go to a mountain top (or
wide open parking lot) to take the first measurement. Drive the DF vehicle at low speed
and take some measurements from there. Plot onHuntMaster's map onlyone bearing at
the end of each transmission (so that the Radar accumulates all the measurements
received during the transmission). Repeat the process from another second hill top, or
clear place. Now youcanalso start travelling in the direction indicated by the bearing lines
intersection on the map. The DF Operator is encouraged to perform some additional
measurements while travelling to the intersection spot, increasing the precision of the
signal source localization.

8. A FINAL NOTE ON REPEATERS

Some newcomers may believe that erroneous bearings may be produced by the existance of
repeaters that cause bearings to bounce back and forth. Nevertheless, once repeaters are
understand, the user will understand that this is not possible to happen, as this systems have two
different frequencies. One for receptionof the mobile user, and one for transmitting the repeated
signal. This originates what is called a 'repeater shift'. If youhave a repeater frequencyof461MHz
with a repeater shift of +5MHz, this means that the repeater retransmits on 461MHz what it
receives in466MHz. The short notation for a 461MHzrepeater witha +5MHzrepeater shiftwould
be: 461MHz+5MHz. Of course, this general comments are only for analog repeaters. Therefore,
the user should understand the exact technology behind the signals he is intending to locate.

As a general rule, repeaters cannot cause DF bearing angle volatility because they have a
separate input and output channels. The onlyDF related problem whenusing repeaters is that if
the user tunes his DF Radio Receiver to the transmission frequency of the repeater, then all
stations using the repeater will generate the same bearing angle in the DF System. This happens
because he will be tracking down the localization of the repeater instead of the location of the
mobile users he may be more interested in locating.

To determine an analog repeater's input frequency in the UHF Band the user should normally
check +/-5MHz from the repeater's output. The output is easier to find, as all stations will be
getting out of the repeater system, and the user will have a higher S-Meter Indication.

mailto:info@HuntMaster.com.ar
http://www.HuntMaster.com.ar


info@HuntMaster.com.ar - Copyright © 2008 by HuntMaster Corp - www.HuntMaster.com.ar

 55 of 66 - Operator’s Manual - HuntMaster Corp.

B. AUTO BEARING LINE TRIANGULATION

This is the simplest help guidence provided by HuntMaster to the DF Operator. When two or
more bearing lines are avaliable, this feature activates, providing the user with:

· Indicates the intersection of the last two bearing lines with a 'star' icon on the map.

· Provides the Geographical Coordinates of this intersection point in the same numeric
format than the rest of the coordinates used thruought the application. These coordinates
will be displayed below the GPS coordinates in the Map Window.

NOTE: If the two bearing lines don't intersect (because they have divergent angles)HuntMaster
calculates the 180 degree out of bearing line, and uses it to estimate a probable "back"
intersection spot. This feature has been added, as sometimes multipath makes a
measurement to be 180 degree out of its course.
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C. USING THE MAXIMUM LIKELIHOOD PROBABILISTIC REGION
DISPLAY

Based on a map and a set of DF measurement, HuntMaster can calculate the most probable
region for the RF Signal Source to be found. To do so, just press Ctrl-R shortcut, and wait until the
Probabilistic Model is resolved. Youwill thensee anellipse colored area on the map. This is the
most probable region were the Signal Source comes from based on the amount of
measurements available. A usuall mission plot may have the following shape:

This colored layer is overlapped over the map showing the most probable region for the unknown
RF Signal Source to be found. This areas are colored from a light yellow (minimum probability)to
a dark red (maximum probability).

In this case, the region has an elliptical pattern. The exact shape depends on the localization
where the measurements have been taken. In a two measurement case both of them are
measured very near from one another, then a very elliptical pattern is formed (in the axis where
the measurements are done). This is the consequence of error propagation probability in the
mathematical model. Intuitively is also clear that if you take two measurements very near from
eachother, thenyouwill probablyhave a good direction indication, but a very inaccurate distance
indication. This is depicted by the MLPR Display with this highly elliptical pattern.

Of course there are infinite shapes that canbe formed whenmore and more measurements are
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taken into account. This also increases the precision of the region displayed as been the most
probable for the unknown location of the RF Source to be. In the limit, when the amount of
information (measurements) tends to infinite, this ellipse tends to be just a point on the map
displaying the exact position of the transmitter (of course if there are no biasing errors in the DF
measurements).

It is important for the DF Operator to know that each time the map is zoomed in/out, or moved in
any direction the MLPR displayed overlaywill be erased. He should press Ctrl-R after eachmap
view change to Recalculate the MLPR Display.

Tip: Keep in mind that under certain circumstances (such as when 2 or more transmitters are
keyed alternatively) it is possible to see two different colored regions (or more) overlappedover
the map. This can also happen when some of the radiogoneometric measurements havebeen
systematically biased. This could happen when 'night effect' or 'shore effects' are taking place.
Under this circumstances, a false high probability region could be displayed together with the
actual region. It is therefore always important for the DF Operator to understand the
environment where he is operating the RDF System.

COLOR PROBABILITY AUTOSCALING

The MLPR color scale may change as you go through zooms, or view area changes. This is
because each time the MLPR Moder is run by HuntMaster it also recalculates the color scale
probability reference (sensitivity) based on the probability values of the area under display.
Therefore, if you zoom into a low probability are, the algorithm will automatically increase the
sensitivity (and color brightness) of that area to compensate. This automatic MLPR probability
brightness control cannot be overridden manually. Nevertheless, there is a manual brightness
control ('MLPR Br' Slider Control) that modifies +/- 10 log probability units the automatically
selected brightness threshold. This is much like the way the Automatic Exposure Control of
Digital Photo Cameras works.

The 'MLRP Br' Slider Control is seldom used. It increases/reduces the MLPR color scale
sensitivity (brightness). Sometimes when the DF Operator is tracking downmore thanone signal
at a time, or when the signal source does not appear as at a clear spot we may find usefull to
increasing the MLPR sensitivity. As this will assignadditional probabilities to places overlooked
in first place.This control slider is not required for normal DF operation. It is only usefull for
advanced operationand to learnhow the MLRP Model works. Therefore, the suggestion isforthe
average user not to modify this control from the 0 (center) slider positionduring normal operation.

Advanced users may want to increase the Silder to positive values when there are lots of
measurements plotted, and none of them tend to give a clear indication. When this happens, the
MLPR Model may not show any overlay at all (as probabity areas are too low). Under this
scenario, the user can place the 'MLRP Br' Slider at +6 or +7 to have a visible indicationof the
most probable regions where the RF Source may be located. Nevertheless, the user should be
awared, that overall probabilities are very low. This could indicate that there are various RF
Sources on the same frecuency, or that some measurements have veryhighaccurancyproblems.
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HIDING/UNHIDING THE MLPR OVERLAY

As the MLPR Overlaycanhide certainmap details, it is important to have some quick way tohide
the Overlay to look on the map, and turn it back on again. This is the Ctrl+"S" shortcut. It
shows/hides the MLPR Overlay. This shortcut responds very quick so the user can hide the
MLPR, see the map below the colored area, and turnback on the MLPR ina matter of a second
or so.

ABOUT MLPR VISUAL RESOLUTION

The MLPR Model works with a 128 by 100 pixel resolution. Therefore, the user will appreciate
that the map has a much higher resolution (usually 500x400 pixels) than the overlaid probability
layer. This will produce bigger colored pixels in the region where the probability layer is not
transparent. This is normal, and is the result from a 'processing time versus pixel size' tradeoff.
Nevertheless, as the user increases the zoom over a certain region of the map, the probability
layer pixels remain constant insize, and therefore are relativelysmaller compared with the ones
from the original map image. So the overall precisionof the MLPR Model is nondependant ofthe
pixel visualization size. As each time the map is zoomed, and the MLPR Model re-run, the new
smaller map view is recalculated.

The MLPR Model is calculated one measurement at a time. Therefore, the time it takes to
calculate the whole area is dependant on the number of measurements. Ina Pentium III700Mhz
MMX each measurement requires approximately 0.1 seconds of CPU processing. Then a 10
measurement hunt will require of 1 second to be processed by the MLPR Model.

HOW DOES THE MLPR MODEL WORKS(For Advanced and curious users only)

The software runs a Homosedastic Maximum Likelihood Probabilistic Model, based on some
key assumptions of every one of the measurements. It is important to understand the logic
underneath the algorithm to have a better interpretation of the results.
Model assumptions:

1- All measurements have a Normal (gaussian) distributionerror which is thereforeunbiased
(by definition of normal distribution).

2- Therefore there are no systematic errors on DF bearing lines (this is important at high
latitudes, as the Digital Compass, or GPS derived Heading should be reporting magnetic
field adjusted Compass measurements for high accuracy operation).

3- Amplitude error of a certain measurement is fixed (indegrees). So the absolute error (in
feet) of a measurement is proportional to the distance from where the measurement has
been taken. This is the same that to say that the Standard Deviation of the normal
distribution is proportional to the distance from the point where it has been taken to the
point where the RF Signal Source is located (Homosedastic Function).
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4- All measurements are independent from one another. This implies that a certainerror of
one measurement in one direction is totally independent from the error of the next
measurement taken. This implies that (for instance) the calibration error of the DF Units
involved is zero. If not, all measurement will have a commonnonNormal distributed error,
that will generate noncanceling errors in the algorithm. The same occurs if measurements
are taken while in motion and undertaking sharp turns. For best performance of the
Probabilistic Model, and to have an accurate Maximum Likelihood region this kinds of
biasing errors should be avoided.

5- It is supposed that map longitude and latitude coordinates are totallyaccurate. The same
is true of GPS position.

CONFIGURATION OF THE STANDARD DEVIATION CONSTANT

For the MLPR model to work, a key assumption about the standard deviation of the bearing
errors should be made. This value should be modified accordingly to the accuracy of the DF
measurement equipment used and the environmental conditions inwhich it is operated (e.g.City,
Country Side). For instance, for fixed site RDF measurements, thena 2 to 4 degree of standard
deviation is suggested. As the RMS error of a Professional Grade RDF Unit under this
circumstances can achieve this small error values. Whenworking mobile, then this value should
be increased into the 5 to 10 degree range. To modify the Standard Deviationconstant selectthe
'Map' tab from the 'Options' form from the 'Tools' menu.
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SECTION VIII - MAPS

A. WHAT IS A MAP?

A map in HuntMaster software suit is an image of a map which has been calibrated
(georeferenced) so HuntMaster can use any pixel position on the map to determine the true
geographic position. When you calibrate a map using HuntMaster Map Module creates a .map
file whichcontains the calibration informationand a link to the image youare using. This files are
compatible withOziExplorer (www.oziexplorer.com) version3.xor higher .map files. Theusercan
therefore use this shareware software to georeference an image file.

If the user is going to create a map image byscanning it or using an image file, he should make
sure that the image has north in the upward direction, so that latitudes become horizontal and
longitudes vertical. This is one of the main differences between an image and a map. If it is a
paper image then use a scanning software to save the image as a graphics file.

The other method of creating maps is to import them. There are maps and charts available in
digital form whichhave the calibration (georeferencing) for the map included either directly in the
file or provided as information in an additional file. Importing these maps reads the calibration
information from the map files and creates an OziExplorer map file.

B. CREATING MAPS FOR HUNTMASTER

Where do a user obtain the map images from - he can obtain them from 3rd parties who have
produced them in digital form as images or youcanscan them for himself. The user has several
ways to create map files. With HuntMaster an image can be imported and assign latitude and
longitude coordinates to it (georeference the map). Then save the file (in .map format) and the
user is ready to use the map in Map Module. To create a map, the user can first create a map
image (using a scanner) and store it ina graphics file. Scan the maps at or about 125 to 200 dpi
(dots per inch) with 16-bit color. The dpi can be modified to suit your requirements, colors
settings should be at least 16-bit resolution. The amount of control you have for setting these
parameters depends on your scanner and its software. Save the scanned image as a BMP file,
althoughother image files are supported, it is very important to achieve best performance to use
a non compressed file format. The reason why this is necessary is because when the Map
Module has to re-draw the map windows the image file has to be read and decompressed. This
decompressionprocess is slow, and reduces the software response to users movements on the
map. Alternativelya map image canbe created using a commerciallyavailable map programlike
MapExpert (by DeLorme Mapping).

There are some things youshould consider whenmaking a HuntMaster map. If the map hasmany
details and/or is very dark, you might find it hard to see bearings on the screen. It is advisable to
use a map with fairly pale colors or with limited detail.
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The next step is to georeference the image by assigning coordinates to it. To perform this task,
the user has to know the latitude and longitude of at least 2 points on the map (preferably near
opposite corners of the image to reduce errors to a minimum). As stated above the
Latitude/Longitude lines must run parallel to the edges of the screen for the calibration to be
acceptable.

C. CALIBRATING (GEOREFERENCING) AN IMAGE FILE

From the Map menu select the Calibrate Map Image option. Using commands in this form the
user assign coordinates to his pixel image by specifying the latitude and longitude of two
locations on the image.

Thus, the user needs to know the latitude and longitude of two points that he can identify in the
image and select with the mouse. He is free to choose any two points, except that they must
define a rectangle (theycannot line up). To achieve maximum precision, the user should see to it
that the two points are fairly far apart, preferably along a diagonal of the image (and near
opposite corners of it). The procedure to georeference the map is as follows:

1- Select First Point: Determine the location (latitude and longitude) of the first point. After
selecting this tab the user should move the cursor to the right locationand double click the
mouse. The location you have chosen is marked with a black cross on the image. Enter
the latitude and longitude in the tab locationdialog box. If youare not satisfied, repeat the
process to re-select the correct pixel for that location.

2- Select Second Point: Determine the location (latitude and longitude) of the first point.After
selecting this tab the user should move the cursor to the right locationand double click the
mouse. The location you have chosen is marked with a black cross on the image. Enter
the latitude and longitude in the tab locationdialog box. If youare not satisfied, repeat the
process to re-select the correct pixel for that location.

3- Once you successfully selected both calibration locations on the image press the Apply
button. The image will now be re-scaled to the corresponding map scale.
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4- The user should now save the map. From the File Menuselect the Save Option, thenclick
to save in .map format. All georeferencing informationwill be stored in this file and a linkto
the image file you are using will be stored on that file. Therefore, the path to the image
must not change from this moment onwards. This .map files are compatible with
OziExplorer (www.oziexplorer.com) version 3.x or higher .map files.

Once you have assigned coordinates, you can check the coordinates of any locationbymoving
the mouse while pressing down the left button. The latitude and longitude of the cursor location
are displayed at the top of the Map Module screen.
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SECTION IIX - ADVANCED USER INFORMATION

A. ADVANCED CONFIGURATION

CHANGING THE DEFAULT SCREEN SIZE

By default HuntMaster is configured for 1024x768 resolutionmonitors. Other resolutions canbe
accomodated by manual configuration of the HM.INI file. For the average user, HuntMaster
window can be resized by dragging it with the mouse. The Map Window canalso be resized by
dragging. In this case, the user should resize the Map Window to the desired vertical highthofthe
window. HuntMaster will automatically determine the correct width for that height. To change the
default size settings to accomodate other monitor resolutions the HM.INIfile has to be edited.The
INI text lines to modify are the following:

· Map Window Size: Locate the line 'MapHeight=539' and edit the number of pixelsasper
the user requirements. Please note that the Map Window Width is automaticallycalucalted
based on the Height been selected.

· Main Window Size: Locate the lines 'MainHeight=634' and 'MainWidth=1024'.Editthem
so that the number of pixels best fit your computer's screen.

B. SHORTCUTS

Eachof HuntMaster's Modules has a certainset of shortcut keys. Most of this commands require
to first press the Ctrl key and then the shortucut key. WhenHuntMaster is running, it captures the
keyboard in such a way that the shortcuts will work all the time (even if the focus is on another
program). That’s why almost all the shortcuts require the Ctrl key to be pressed. While in a
mission, it is suggested that the DF Operator mantains the Ctrl key pressed at all times while
using HuntMaster. There is no way of disabling the shortcuts except by closing the program.

Care should be takennot to leave the focus ona Slider whenusing certainshortcuts (suchas the
PgUp, PgDn or Zoom shortcuts) as this could have two effects: To change zoom scale, and to
move the slider at the same time.

SoftDoppler Module shortcut table

Key Description

Shift Whenpressed the audio filter’s bandwidth is increased by10(fast
response)
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Radar Module shortcut table

Key Description

Ctrl-C Clear Radar's Persistence (Mode Reset)

Ctrl-T Timer Reset

Map Module shortcut table

Key Description

Ctrl-PgUp Zoom In (x1.2)

Ctrl-PgDn Zoom Out (x1.2)

Ctrl-X Open Next Higher Definiton Map of this area

Ctrl-Z Open Next Lower Definiton Map of this area

Ctrl-M Map's Coverage Display (Show/Hide)

D+Left Click Open Highest Resolution Map available of the clicked location

Left Click Pressing the Left Mouse Buttonwhile moving the mouse cursor to
the location of a Waypoint, will pop-up a Waypoint Information
Window

Ctrl-I Move Map Up (1/6 screen)

Ctrl-K Move Map Down (1/6 screen)

Ctrl-J Move Map Left (1/6 screen)

Ctrl-L Move Map Right (1/6 screen)

Ctrl-R Recalculate MLPR Display

Ctrl-S Hide/Unhide the MLPR Overlay

Ctrl-F1 Show Manual/External DF Entry Window

Ctrl-F2 Show DF Mode Angle Entry Window

Ctrl-F3 Plot DF Mode onMap and Clear Persistence (suggested plotting
method)

Ctrl-F8 Erase all Mobile Waypoints older than 5 minutes

Ctrl-F9 Erase all Mobile Waypoints older than 10 minutes

Ctrl-F10 Erase all Mobile Waypoints older than 15 minutes
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C. HUNTMASTER FILE INFORMATION

FIXED FOLDER STRUCTURE

HuntMaster has a fixed sub-folder organization structure, where the different types of files are
stored. The user will find the following files in the sub-folders as per the following table:

· Map files: '.map' files in sub-folder: \Maps

· Waypoint files: '.wpt' files in sub- folder: \Wpts

· Hunt (Mission Logging) files: '.hm' files in sub- folder: \Hunt

The Intelligent Default Folder algorithm automaticallyselects the correct folder based on the type
of file the user is going to open/save.

'.HM' HUNT FILES DESCRIPTION

In this file HuntMaster stores three types of events:

· Map Changes: If a new map is loaded, then the new map opened is logged into the file

· Waypoint Plotting: Any new Waypoints plotted on the map (together with all their
information) is logged into the file

· GPS Tracks: All the GPS tracks of the different DF Stations available will be plotted on
the map as separate track lines

GPS Track information is recorded every 4 seconds including the following additional fields:

Name Value Description

DF Station
Address

DFxx-Track Where xx indicates the Address of the DF Station been
logged

GPS Latitude xx.xxxxxx Degrees and Fractions of Degrees

GPS Longitude xx.xxxxxx Degrees and Fractions of Degrees

Code Reserved 1 -

GPS Altitude Meters A value of -777 means no altitude information available

Date & Time xxxxx.xxxxxxx IEEE Data & Time Format

Reserved 2 Reserved 2 -

Reserved 3 Reserved 3 -
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RDF Bearing
Angle

xxx.x Degrees and Fracions of Degrees

Radar Mode xxx Degrees. Rounded to 1, 2, 3, 4, 5 degrees. Depends on
Radar Configuration

RDF Hold x Boolean Value. 1 (True) when RDF Unit is On Hold / 0
(False) if RDF Data is flowing

Reserved 4 Reserved 4 -

RDF Bearing
Quality

xxx Using SoftDoppler: Numerical value corresponding to
Signal Qlty #1 Meter. Range from [-20db, 0db]. 'RDF
Products' RDF Units: Bearing Length value. Range from
[0, 999]

RDF Bearing
Quality 2

xxx Using SoftDoppler: Numerical value corresponding to
Signal Qlty #2 Meter. Range from [-20db, 0db]. 'RDF
Products' RDF Units: not used

RDF Bearing
Quality 3

xxx Using SoftDoppler: Numerical value corresponding to
Signal Qlty #3 Meter. Range from [-20db, 0db]. 'RDF
Products' RDF Units: not used

GPS Speed xxx.x Knots (Miles per Hour)

Heading xxx Heading in Degrees. If no Digital Compass Information is
available, then GPS Heading is used
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